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Abstract

These Application Notes describes the steps to configure Session Initiation Protocol (SIP)
Trunking between Voice Carrier and Avaya IP Office Release 8.1.

The Voice Carrier IntelliSIP Trunking Service provides PSTN access via a SIP trunk between
the enterprise and the Voice Carrier network as an alternative to legacy analog or digital
trunks. This approach generally results in lower cost for the enterprise. Voice Carrier is a
member of the Avaya DevConnect Service Provider program.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 10of32
SPOC 9/17/2013 ©2013 Avaya Inc. All Rights Reserved. VCSipTkIPOS1



1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking between Voice Carrier and Avaya IP Office Release 8.1.

The Voice Carrier IntelliSIP Trunking Service referenced within these Application Notes is
positioned for customers that have an IP-PBX or IP-based network equipment with SIP
functionality, but need a form of IP transport and local services to complete their solution.

The Voice Carrier IntelliSIP Trunking Service will enable delivery of origination and
termination of local, long-distance and toll-free traffic across a single broadband connection. A
SIP signaling interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

The general test approach was to connect a simulated enterprise site to the Voice Carrier
IntelliSIP Trunking Service via the public Internet and exercise the features and functionality
listed in Section 2.1. The simulated enterprise site was comprised of Avaya IP Office and
various Avaya endpoints.

The Voice Carrier IntelliSIP Trunking Service passed compliance testing with any observations
or limitations described in Section 2.2.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Use of UDP or TCP for the transport layer to the service provider

¢ Sending and receiving SIP OPTIONS queries to the service provider

¢ Incoming PSTN calls to SIP and H.323 telephones at the enterprise. All inbound PSTN
calls were routed to the enterprise across the SIP trunk from the service provider.

¢ Qutgoing PSTN calls from SIP and H.323 at the enterprise. All outgoing PSTN calls
were routed from the enterprise across the SIP trunk to the service provider.

¢ Inbound and outbound PSTN calls to/from soft clients. Avaya IP Office Video
Softphone and Avaya Flare® Experience for Windows were tested.

e Various call types including: local, long-distance, outbound toll-free, international and
local directory assistance.

® Codec G.711MU
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Caller ID presentation and Caller ID restriction

DTMF transmission using RFC 2833

Voicemail navigation using DTMF for inbound and outbound calls.
User features such as hold and resume, transfer, and conference.
Off-net call forwarding and twinning

G.711 pass-through fax

REFER message for network call redirection

Inbound toll-free calls and 911 emergency calls are supported but were not tested as part of
the compliance test.

The following items are not supported:

G.729 codec
Operator (dial 0) and operator-assisted ( dial 0 + 10 digits) services
T.38 Fax

2.2. Test Results

Interoperability testing of the Voice Carrier IntelliSIP Trunking Service was completed with
successful results for all test cases with the exception of the observations/limitations described

below.

Codec not locked down on outbound calls: On outbound calls, Voice Carrier responds
to the INVITE request with multiple codecs, instead of selecting one from the INVITE
SDP list. IP Office uses the first compatible codec in the list. This behavior has no user
impact. Calls were successful.

Inconsistent SIP headers on inbound Calling Party Number blocked calls: On
inbound Calling Party Number (CPN) blocked calls, Voice Carrier sends a SIP INVITE
message containing two headers which contradict each other. The INVITE contains the
Privacy = none header which indicates that the calling party number should not be
blocked. The INVITE also contains the Remote-Party-ID header with parameter
privacy=full which indicates that the calling party number should be blocked. In this
scenario, IP Office blocked the calling party number as intended. The call was
successful.

Blind transfer with Avaya 1100 IP Deskphones calling party number: An Avaya
1100 Series IP Deskphone (SIP) places an outbound call to the PSTN, then performs a
blind transfer of this call to another PSTN endpoint. In this scenario, the wrong calling
party number is displayed on the second PSTN endpoint. The display shows the number
dialed by the Avaya 1100 Series IP Deskphone for the initial outbound call including the
short code (9) + 1 + 10 digits. The behavior is expected to be the same as with IP Office
H.323 endpoints which is to display the transferring party number. This is an IP Office
issue and is under investigation by the IP Office development team.
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2.3. Support

For technical support on the Voice Carrier IntelliSIP Trunking Service, contact Voice Carrier
using the Support links at www.voicecarrier.com or by calling 1-888-830-6230.

3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Voice Carrier IntelliSIP Trunking
Service.

Located at the enterprise site is an Avaya IP Office 500 V2 with various endpoints. The LAN
port of Avaya IP Office is connected to the enterprise LAN while the WAN port is connected to
the public network. The site also has Avaya Preferred Edition for voicemail and Avaya IP
Office Manager to configure the Avaya IP Office running on a single Windows 2003 Server.
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Figure 1: Avaya Interoperability Test Lab Configuration

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits
across the SIP trunk to Voice Carrier. The short code of 9 and any preceding 1 is stripped off by
Avaya IP Office and the remaining 10 digits were sent unaltered to Voice Carrier. For outbound
calls, Avaya IP Office sent 10 digits in all headers. For inbound calls, the Voice Carrier
IntelliSIP Trunking Service sent 10 digits in the Request URI and the To field of inbound SIP
INVITE messages.
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In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond
the scope of these Application Notes. However, it should be noted that SIP and RTP traffic
between the service provider and the Avaya IP Office must be allowed to pass through these
devices.

4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment Software
Avaya IP Office 500 v2 8.1 (69)
Avaya IP Office Manager 10.1 (69)
Avaya IP Office Preferred Edition 8.1 (9203)
(Voicemail)
Avaya 1140E IP Deskphone (SIP) 4.3 SP1 (04.03.12.00)
Avaya 1608 IP Deskphone (H.323) running 1.3 SP3 (1.3.3)
Avaya one-X® Deskphone Value Edition
Avaya 9641G IP Deskphone (H.323) running 6.2 SP2 (6.2209)
Avaya one-X® Deskphone Edition
Avaya IP Office Video Softphone (SIP) 3.2.3.48 (67009)
Avaya Flare® Experience for Windows 1.1.2.11

Voice Carrier Components

Equipment Software

IntelliSIP 2.1 -avl.6.2.18

Testing was performed with IP Office 500 V2 R8.1, but this testing also applies to IP Office
Server Edition R8.1. Note that IP Office Server Edition requires an Expansion IP Office 500 V2
R8.1 to support analog or digital endpoints or trunks. Also, IP Office 500 V2 does not support
SIP Direct Media so Server Edition SIP Direct Media functionality was not compliance tested.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs - IP Office > Manager to launch the
application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Open Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials. The appearance of the IP Office
Manager can be customized using the View menu. In the screens presented in this document, the
View menu was configured to show the Navigation pane on the left side, omit the Group pane in
the center, and show the Details pane on the right side. Since the Group Pane has been omitted,
its content is shown as submenus in the Navigation pane. These panes (Navigation, Group and
Details) will be referenced throughout the Avaya IP Office configuration. All licensing and
feature configuration that is not directly related to the interface with the service provider (such as
twinning and IP Office Video Softphone support) is assumed to already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 32
SPOC 9/17/2013 ©2013 Avaya Inc. All Rights Reserved. VCSipTkIPOS1



5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License =
SIP Trunk Channels in the Navigation pane. Confirm a valid license with sufficient Instances
(trunk channels) in the Details pane.

IP Offices =) SIP Trunk Channels e -

R BOOTP (4) #| | Licenses
(7 Operator (3)
Alantic City License Key | TyKoFSl s b 3w
5y System (1)
9 Line (12) License Type  |SIP Trunk Channels
Control Unit 33
4 Extension (Z5)
& userze)
H ﬂ HuntGroup (1)
@ Short Code (61) Expiry Date | Mever
B Service (0)
ol RAS (1)
=] @ Incoming Call Route {19
Eﬂ anPort {0)
a4 Directory (0)
£179 Time Profile (0
@ Firewall Profile {1}
(- Jill IP Route (4)
@ Account Code (0)
= W License (77}
B 1600 Series Phones
& 3rd Party IP Endpoil
. Advanced Edition
W Advanced Small Cor
B ALDT: Woicemall
. Avaya IP endpoints
& Avaya IP endpoints
. Branch Edition

License Status | Valid

Instances 255

&
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To view the physical hardware comprising the IP Office system, expand the components under
the Control Unit in the Navigation pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital stations ports, two analog extension
ports, 4 analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module
supporting VoIP codecs. An IP Office hardware configuration with a VCM component is
necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices ot IP 500 V2 =
K EOOTR(4) Uik
i Operator (3)
= Atlantic City Device Humber :
= System (1) Uit Type IP 500 ¥2
T Line (14)
=== Conkral Unik {3 Yersion 8.1 (69
o 1IPSOOYE
= 2 COMBOBZ10fATM || Serial Number UM 5
“ir 3 DIGSTASIATMY
it IP Add 10.32.178.25
Ay Extension (25) n s
ﬂ User (27) Interconnect Mumber 1]
ﬁ HunkGroup {173
B Short Code (61) Module Number Conkrol Lnit
@ Service (0}
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5.2. System

Configure the necessary system settings.

5.2.1. System - LAN2 Tab

In the sample configuration, the WAN port was used to connect the Avaya IP Office to the
public network. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500.
To access the LAN2 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the IP Office. In the case of the compliance test, the system name is Atlantic
City. Next, navigate to the LAN2 = LAN Settings tab in the Details Pane. Set the IP Address
field to the IP address assigned to the Avaya IP Office WAN port. Set the IP Mask field to the
mask used on the public network. All other parameters should be set according to customer

requirements.

R BOOTP (4)
Operator (3)

) Aklantic Ciky

[=)-*%p System (1)

“ap mblantic Ciky

#-F7 Line {14)

[#-#2 Control Unit {3)

-4 Extension (25)

[E5| § User (273

[E3] ﬂ HuntGroup (1)

-9 short Code (61)
B ervice (0)

[y RAS (1)

7] @ Incoming Call Route {28}
@ WanPork (1)
s Directory (1)
£ Time Profile (0)

IP Offices =

System | LAM1 | LANZ | DNS

IP Address

IP Mask

Primary Trans. IP Address
Firewwall Profile

RIF Mode

DHCP Maode

Mumber OF DHCP TP Addresses (200 %

Atlantic City

Yoicernail | Telephony | Directory Services | System Events | SMTP | SMDR

LAM Settings | woIP || Mebwork Topology | SIP Reqistrar

192 . 168 . 96 . z32

255 . 255 . 285 . 224

a 0 0 0

: <None = w
Mare b
[] Enable MaT

=

& @ Firewal Profil (1) O server O Client (O Dialin (&) Disabled A

=-J§ll IP Route (4)
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On the VoIP tab in the Details Pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. The RTP Port Number Range can be customized to a specific
range of receive ports for the RTP media. Based on this setting, Avaya IP Office would request
RTP media be sent to a UDP port in the configurable range for calls using LAN2. Avaya IP
Office can also be configured to mark the Differentiated Services Code Point (DSCP) in the IP
Header with specific values to support Quality of Services policies for both signaling and media.
The DSCP field is the value used for media and the SIG DSCP is the value used for signaling.
The specific values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient, appropriate
values will be provided by Voice Carrier. All other parameters should be set according to
customer requirements.

E Atlantic City £ R AR

Syskem | LaM1 | LANZ | DNS | Vaoicemail | Telephony | Directory Services | Swstem Events | SMTP | SMDR | Twinning | ¥CM | CCR | Ca

LaM Settings | YoIP | Network Topology || SIP Reqistrar

H.323 Gatekeeper Enable
SIP Trunks Enable
1P Registrar Enable

R.TF Port Mumber Range

[] H.323 Auto-create Extn
Port Range (Minimum) (#9152

43

H.323 Auto-create Lser Port Range (Maximum)  |53246

4

[] H.323 Remote Extn Enable

Enable RTCP Monitoring
on Part S005

DiffSery Settings

B | DSCP(Hex) FC 3| DSCPMask(Hex) |55 3| sispsce {Hex)
46 % | DScP 63 3| DSCP Mask 3 3| slaDscP
DHCP Setkings
Primary Site Specific Option Mumber (S30M) 176 &
Secondary Sike Specific Option Murnber (550N 242 S
YWLAN Mok Present b
1100 Yaice YLAN Site Specific Option Mumber (S50N) 232 <)
1100 Yoice YLAN [Ds
RTP keepalives
Scope Disabled A
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On the Network Topology tab in the Details Pane, configure the following parameters:

Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet.

Set Binding Refresh Time (seconds) to 60. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service

provider.

Set Public IP Address to the IP address of the Avaya IP Office WAN port.

Set the Public Port to the port Avaya IP Office will listen on.
All other parameters should be set according to customer requirements.

= Atlantic City

Swstem | LAM1 | LAMZ  |DNS | Waicemail | Telephony | Directory Services | System Events | SMTP | SMDR. | T
Lal Settings | woIP | Mebwork Topalogy | SIP Registrar
Mebwork Topology Disconvery
STUM Server IP fddress 10 Ll 165 13 STUM Port 347E %
Firewall/NAT Tvpe Cpen Inkernek W
Binding Refresh Time &0 =
(seconds) s
Public IP Address 192 . 165 9 232
Public Park S060 % Run STUM Cancel
[] run 5TUM on startup
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding

and call transfer to the PSTN.

If for security reasons incoming calls should not be allowed to

transfer back to the PSTN then leave this setting checked.

E Atlantic City £ i Al Al

System || LANL | LAMNZ | DNS voicemail | Telephony _Directnry Services | System Events | SMTP | SMDR | Twinning || YCM CCR Codecs
Telephony | Tones & Music | Call Log
Analogue Extensions Companding Law
. Swiktch Line
Default Qutside Call Sequence Taormal |
Default Inside Call Sequence Ring Type 1 v| © U-Law © U-Law Line
Default Ring Back Seguence Ring Tvpe 2 w & oiew ® 5iviihe
Restrict Analogue Extension Ringer Yolkage [
Dial Delay Time {secs) 4 & [] oss status
Dial Delay Count 0 3 . Auka Hald
Default Mo Answer Time (secs) |25 3 Dial By Mame
Hold Timeout {secs) 0 % Shows Account Code
Park Timeout {secs) 300 3- [ 1nhibit CFf-Switch Forward TransFer
Ring Delay (secs) 5 & [] Restrict Metwork Interconnect
Call Priority Promation Time (secs) |Disabled E [] Drop External ©nly Impromptu Conference
Diefault Currency :LISD - [] wisually Differentiate External Call
Default Mame Priority Favo.r Trunk e [ unsupervised Analog Trunk Disconnect Handling
. High Quality Conferencing
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click the OK button at the bottom of the page
(not shown).

Atlantic City

Swskem | LAML || LAMZ | DNS Yoicemail | Telephony | Directory Services || System Events | SMTP | SMDR | Twinning | wCM

[] send ariginal caling party information For Mobile Twinning

Zalling party information For
Mobile Twinning

5.3. IP Route

Navigate to IP Route = 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New (not shown).
Create/verify a default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.
e Set Gateway IP Address to the IP Address of the default router to reach Voice Carrier.
e Set Destination to LAN2 from the drop-down list.

Click the OK button at the bottom of the page (not shown).

IP Offices B 0.0.0.0 ek - X[ v <]

R BOOTP (4 IF Route
{# Operator (3)
[=)-+5=p Atlantic City
(=529 Syskem (1) IF Mask 0 0 0 0
2y Atlantic City
F7 Line (14) Gatewsay IP Address 192 . 168 96 254
< Control Unit (3)
Ay Extension (25)
§ Useriem Metric 0
ﬂ HuntiEroup (1)
8% short Code (1) [ Proxy ARP
@ Service (0)
ol RAS (1)
@ Incoming Call Route (28)
E,ﬂ WanPort (0)
aa Directory (0)
rf" Tire Profile (0}
@ Firewall Profile (1)
=-J§ll IP Route (4)
Eoonoo
Bl 10.32.0.0

IP Address 1} 0 i} 0

Destination LAMNZ L

4 ¥
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Voice
Carrier IntelliSIP Trunking Service. To create a SIP line, right-click Line in the Navigation
Pane and select New = SIP Line (not shown).

5.4.1. SIP Line - SIP Line Tab

On the SIP Line tab in the Details Pane, configure the parameters as shown below.

¢ Set ITSP Domain Name to the domain provided by Voice Carrier.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.2.3, IP Office will include the Diversion Header for calls that are directed
via Mobile Twinning out the SIP Line to Voice Carrier. It will also include the Diversion
Header for calls that are call forwarded out the SIP Line.

¢ Check REFER Support.

e Check the In Service box. This makes the trunk available to incoming and outgoing calls.

¢ Check the Check OOS box. IP Office will use the SIP OPTIONS method to periodically
check the SIP Line. The time between SIP OPTIONS sent by IP Office will use the
Binding Refresh Time for LAN2, as shown in Section 5.2.1.

e Default values may be used for all other parameters.

IP Offices E SIP Line - Line 22 gk -0 K| v <>

=R BOOTP (4) SIP Line [Transport|| SIP URI|WoIP || T38 Fax||SIF Credentials
+-¢# Cperator (3) ]
(=552 Atlantic City Line Mumber 2z 3
(#5557 Syskem (1)
17 Line (14) ITSP Domain Mame | avayatest, calingcloud. net In Service
[#--<=» Control Unit {3}
Use Tel URI
-4y Extension (25) == O
- User (27) Prefix Check 005
(-5 HunkGroup (1)
[+ @5 Short Code (510 Mational Prefix a Call Routing Method Fequest LRI w
@ Service (0] e Criginatar number For
[l RAS (1) Sy 00s forwarded and bwinning calls
- Incoming Call Route (28) International Prefix |00 Mame Prioity System Default hd

@ wWanPort (00

s Direckory (0} Caller IC From From header [

f'.“ Tirme: Profile {00 Send From In Clear O
[+ @- Firewall Profile (1) User-agent and Server
- J§ll 1P Route (43 Headers
W Account Code (0) Send Caller ID Diversion Header w
[+ -8 License (77)
% Tunnel (0) Association Method | By Source IP address b
[+ ﬁ 3 User Rights (8) REFER Su
I pport
- ARS (2
# RAS Location Request {0) Incaming Auko b
[#-Fx E911 Syskem (1)
g Cukgoing Auko w
UPDATE Supported | Mewer -
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5.4.2. SIP Line - Transport Tab
Select the Transport tab. Set the parameters as shown below.
e Set ITSP Proxy Address to the IP address of the Voice Carrier SIP proxy.
e Set Layer 4 Protocol to UDP or TCP as defined by Voice Carrier.
¢ Set Use Network Topology Info to the network port used by the SIP line to access the
far-end and configured in Section 5.2.1.
Set the Send Port to 5060.
e Default values may be used for all other parameters.

E SIP Line - Line 22 :fi‘viﬂl'?‘{|~/|<:|>l

SIF Line| Transport |SIF‘ URI|YoIP | T3 Fax||SIP Credentials
ITSP Proxy Address |192.168.243.180 |
Metwark Configuration
Layer 4 Prokocal |LIDF‘ w | Send Pork |5':'5':' S |
IJse Metwork Topology Info |L.ﬁ.N z w | | |
Expliclt DNS Server(s) | 0O 0 0 o || o 0 0 o |
Zalls Route via Registrar
Separate Registrar |
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5.4.3. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button (not shown). In the example screen below, a new entry is
created. The entry was created with the parameters shown below:

Set Local URI, Contact, Display Name and PAI to Use Internal Data. This setting
allows calls on this line whose SIP URI matches the number set in the SIP tab of any
User as shown in Section 5.7.

For Registration, select 0: <None> from the pull-down menu.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8. Similarly, associate the line to an outgoing line group
using the Outgoing Group field. The outgoing line group number is used in defining
ARS entries for routing outbound traffic to this line in Section 5.6. For the compliance
test, a new incoming and outgoing group 22 was defined that only contained this line
(line 22).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
T SIP Line - Line 22* k- X v < |
X ine -Lineg £ - S R -
SIP Ling || Transport| SIF URT [yalp || T35 Fax||SIP Credentials
Channel  Groups ‘Wia | Local URI  Contack | Display Mame | PAI | Credential | Max Calls add. ..
Remaove
Edit...
Mew Channel
Yia 192.168.96.232
Local URI Ise Inkernal Data "
Conkack Ise Inkernal Data w
Display Mame Ise Internal Data w
PAL Ise Internal Data "
Reqgistration 0: <Maone> 4
Incoming Group 22
Cukgoing Group 22
Max Calls per Channel 10 =
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Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user such as a short code. These URIs are created in the same manner as shown above with the
exception that the incoming DID number is entered directly in the Local URI, Contact, Display
Name and PAI fields.

5.4.4. SIP Line - VoIP Tab

Select the VoIP tab, to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below.

For Codec Selection, select System Default from the pull-down menu. A list of the
codecs in their current order of preference is shown on the right in the Selected column.
The compliance test used the default codec list. To use a custom list of codecs, select
Custom for Codec Selection. Next, move unwanted codecs from the Selected column to
the Unused column. Lastly, move the codecs up or down the list in the Selected column
to achieve the desired order of preference.

Uncheck the VoIP Silence Suppression box.

Check the Re-invite Supported box.

Set the Fax Transport Support to G.711.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

Click the OK button at the bottom of the page (not shown).

B SIP Line - Line 22 e -9 x| vi<|-]

SIP Line| Transport| 5IP URI| ¥0IP T35 Fax| SIP Credentials

Codec Selection Systemn Default - [ volP Silence Suppression

Re-invite Supparted

= @, 711 LLAW &k !
G711 ALAW B4 [ use Offerer's Praferred Codec
5. 729(a) 8K CS-ACELP D Cadec Lockdawn

G.723,1 8kK3 MP-MLO

e ] prAack]100rel Supported

==

Fax Transport Suppoart 5,711 w
Call Initiskion Timeout ¢s) |4 E
DTMF Support RFC2833 L
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5.5. Short Codes

ARS is used to route outbound traffic to the SIP line. A short code is used to route outbound
traffic to ARS. To create a short code, right-click on Short Code in the Navigation Pane and
select New (not shown). On the Short Code tab in the Details Pane, configure the parameters as

shown below.

¢ In the Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Set the Line Group Id to the ARS route to be used which is defined in Section 5.6.

Click the OK button (not shown).

IP Offices

K BoOTR (4)

¢ Operator (3)

[=-%=9 Atlantic City
3y System (1)
9 Line (14)

a User (277

@ Service (1)
ol RS (1)

<2 Contral Uit £3)
Ay Extension (25)

ﬂ Hunt@roup {1}
L+ g Short Code (510

B 9N;: Dial

Short Code
Code an;
Feature Dial w

Telephone Mumber [N
Line Group I0 51: 5P SIF Route ¥
Locale “

Force Account Code [
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”. In the case of the SIP Line to Voice Carrier
documented in these Application Notes, when a user dials *67 plus the number, IP Office will
include the user’s telephone number in the P-Asserted-Identity (PAI) header and will include the
Privacy: Id header. Voice Carrier will allow the call due to the presence of a valid DID in the
PAI header, but will prevent presentation of the caller id to the called PSTN destination.

= “67N;: Dial |
short Cods |
Code *67N; |
Feature |Dial v |

Telephone Mumber |"-"'-"|"-| |

Line Group ID |51: 5P SIP Route v/

Locale | w |

Force Account Code [
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5.6. ARS

ARS is used to route outbound traffic to the SIP line. To define a new ARS route, right-click
ARS in the Navigation pane and select New (not shown). In the Details pane that appears, a
collection of matching patterns (similar to short codes) can be entered to route calls as shown

below.

For the compliance test, two entries were created. The first entry matches on any 1 + 10 digit

number (1XXXXXXXXXX) and then sends only 10 digits (N) in the SIP INVITE message on
the line group defined in Section 5.4.3 (e.g., line group 22). The second entry matches on any
other number (N) and passes it unaltered to the line group 22.

To create an entry, click the Add button and enter the following in the pop-up window.

¢ In the Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.5 followed by a semi-colon.

e Set Feature to Dial. This is the action that the short code will perform.

¢ Set Telephone Number to N” @avayatest.callingcloud.net”. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. In the
first entry, N represents the remaining 10 digits after removing the preceding 1. In the
second entry, the value N represents the complete number passed to ARS. The domain
avayatest.callingcloud.net is the service provider domain provided by Voice Carrier.

¢ Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4.3. This short code will use this line group when placing the

outbound call.

Click the OK button (not shown).

IP Offices

- K BOOTP (4)
[-g Operator (3)
=2y Atlantic City
[#-“%p System (1)
-7 Line (14)
[z Contral Unit (3}
[+ -4y Extension (25)
£ i User (27)
[+-55§ HuntGroup (1)
[+ -@% short Code (617
B Service (0)
ol RAS (1)
(- Incoming Call Route (28)
9 wanPart (0)
ag Directory (00
f:i"‘- Time Profile {07}
-8 Firewal Profile (1)
-l 1P Route (4)
@ Account Code {0}
[+ License (77)
& Tunnel (0)
= ﬁ‘, User Rights (2}
= RS (2)

«# RAS Location Request (0)
-fx E911 System (1)

B SP SIP Route ek -

X[ v]<]

ARS

ARS Route Id [ secondary Dial tane

Route Mame 5P SIP Route

Dial Delay Time Systermn Default (4) ke [ Check User Call Barting

In Service Qut of Service Route <Mone=

l
l

Code Telephone Mumber
L, N'@avayatest.calingcloud. net” Lial 2z
M; M'@avayatest.calingcloud. net” Diial 22

Time Profile et QU 0 Hiours Route «<Monez

Feature Line Group ID

Remave

Edit...
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User = Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Extn243. Select the SIP tab in the Details Pane. The values entered for the
SIP Name and Contact fields are used as the user part of the SIP URI in the From and Contact
headers for outgoing SIP trunk calls and allow matching of the SIP URI for incoming calls
without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.3). The
example below shows the settings for User Extn243. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from Voice Carrier. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving
this user and a SIP Line should be considered private, then the Anonymous box may be checked
to withhold the user’s information from the network.

Click the OK button (not shown).

IP Offices :

‘S BOOTR (4) User | Vaoicemail | DMD ShortCodes || Source Mumbers | Telephony | Forwarding | Dial In | Woice Recording
i Operator (3)

Extn243: 243

(-39 Atlantic City Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership | Announcements | SIP Perd
" System (1) SIP Name 9725551236
T4 Line (14)
“2r Control Unik {3) SIP Display Mame (alias) |[Extnz243
A& Extension (25)
a Conkact 9725551236

ﬁ Huntaroup (1)

@ short Code (61)
B Service (0

o RAS (1)

D Anonymaus
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New (not shown).

5.8.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details Pane, enter the parameters as shown below.
e Set the Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section
54.3.
e Set the Incoming Number to the incoming number on which this route should match.
e Default values can be used for all other fields.

IP Offices = 22 9726661236 ol -8 x|
@ ﬂ BOOTR (4) | Standard Voice Recarding | Destinations
+]-4% Operator (3)
Atlankic Ciky
[+ 550 Syskem (1) Bearer Capability | Arry Yaice |
#-T4 Line {14) _
[#-== Conbrol Urit {3) Lime Group ID 2z “
-4 Extension (25) Incoming Mumber 725551236
[+ ‘ User (27)
5§ HunbGroup (1) Incoming Sub Address
- @M Short Code {61}
@ Service (0 Incorming CLI
I+ o RﬁS() - — Locale | |
[ e Incoming Call Route (25)
K@) wanPort () Priority 1 - Low v
i Directary (0 -
f-f" Tirne Profile (0) Tag
:: % IT;“;:L':EE;IIE w Hold Music Source _Sv_stem Source v.j
i Account Code (0)

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
9725551236 on line 22 are routed to extension 243.

=
22 9725551236 Bt - XK wl=<]>

Standard | Yaice Recording | Destinations

TirmePrafile Destination Fallback. Extension
L Default Value 243 Extnz43 w w
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Incoming Call Routes for other direct mappings of DID numbers to IP Office users listed in

Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

CTM; Reviewed:
SPOC 9/17/2013

r

Save Configuration

IP Ciffice Settings
Atlantic Ciky
Configuration Reboaot Mode
(%) Merge
) Immediate
) When Free
2 Timed

Reboot Time

Call Barring

[ QK H Cancel ][ Help

Solution & Interoperability Test Lab Application Notes

©2013 Avaya Inc. All Rights Reserved.

24 of 32
VCSipTkIPO81



6. Voice Carrier IntelliSIP Trunking Configuration

Voice Carrier is responsible for the configuration of the Voice Carrier IntelliSIP Trunking
Service. The customer will need to provide the IP address used to reach the Avaya IP Office at
the enterprise. In the case of the compliance test, this is the Avaya IP Office LAN2 public IP
address. Voice Carrier will provide the customer the necessary information to configure the
Avaya IP Office SIP connection to Voice Carrier including:

e Voice Carrier SIP domain
IP address of the Voice Carrier SIP proxy
Supported codecs
DID numbers
All IP addresses and port numbers used for signaling or media that will need access to the
enterprise network through any security devices

7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

7.1. System Status

The System Status application is used to monitor and troubleshoot IP Office. Use the System
Status application to verify the state of the SIP trunk. System Status can be accessed from Start
- Programs > IP Office > System Status.

The following screen shows an example Logon screen. Enter the IP Office IP address in the
Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

M3 1P Office RB.1 System Status

AVAYA IP Office System Status

Help Exit About

Online | offline

Logon

Control Unit IP Address: [plickabiye)

Services Base TCP Port: FEDHES

MBIV T EE Adninistrator

Password: ............Ol

M Auto reconnect
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

Help Snapshot  LogOff  Exik

Lines: 5 -
Line: 17
Line: 18
Line: 19
Line: 20

About

Peer Domain Marne:
Resolved Address:
Line Murnber:

Mumber of Administered Channels:

Mumber of Channels in Use:
Adminiskered Compression:
Silence Suppression:

SIP Trunk Channel Licenses:

SIP Trunk Channel Licenses in Use:

SIP Device Features:

IP Office System Status

Alarms

SIP Trunk Summary

awvayatest.calingcloud. net
192.168.243.180

10

1]

G711 Mu, G711 A, G729 4, Q7231
Off

Unlirnited

o~
0

REFEF. {Incoming and Cukgoing)

Direcki,,, Round
Trip On,

Alarms

alarms for Line: 22 SIP avayatest.callingcloud.het

OCCUrrences

Error Descripkion
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7.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor. The application allows the
monitored information to be customized. To customize, select Filters 2 Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked.

A |
T1 | VPN | WiaN | SCN

ATM | cal | DTE | EConf | FrameRely | GOD | H222 | Inteface |
1SON ] Kep/Lamp I Directary ] Media ] FPP 1 R2 ] F\nuting] Services  SIP I S_ustem]

Events

¥ Sip [High - [~ STUN
Packets
[ SIP Reg/Opt A= [ SIP Misc Rx
[~ SIP Reg/Opt T [ SIP Misc Tx
[~ SIPCallRx [~ Cm Motify Rix
[~ SIPCall Tx [ Crn Motify Tx
¥ Sip Rz [~ hex IF Filter [nnn.ann. ann. ann)

v SipTx [~ hex

Default All | Clear Al | TabClear&ll| Tabsetal ok | Concel |

Save File | Load File | Select File |

8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 8.1 to
the Voice Carrier IntelliSIP Trunking Service. The Voice Carrier IntelliSIP Trunking Service is
a SIP-based Voice over IP solution for customers ranging from small businesses to large
enterprises. It provides a flexible, cost-saving alternative to traditional hardwired telephony
trunks. The Voice Carrier IntelliSIP Trunking Service passed compliance testing. Please refer to
Section 2.2 for any exceptions.
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9. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] IP Office 8.1 IP500/IP500 V2 Installation, Document Number 15-601042, Issue 27m, July 2,

2013.
[2] IP Office Release 8.1Manager 10.1, Document Number 15-601011, Issue 29u, April 5, 2013.
[3] IP Office System Status Application, Document Number 15-601758, Issue 07a, November

26, 2012.
[4] IP Office Release 8.1 Administering Voicemail Pro, Document Number 15-601063, Issue 8b,

December 11, 2012.
[5] IP Office System Monitor, Document Number 15-601019, Issue 03¢, March 1, 2013.

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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10. Appendix A: SIP Line Template

Avaya IP Office supports a SIP Line Template (in xml format) that can be created from an
existing configuration and imported into a new installation to simplify configuration procedures
as well as to reduce potential configuration errors.

Note that not all of the configuration information, particularly items relevant to a specific
installation environment, is included in the SIP Line Template. Therefore, it is critical that the
SIP Line configuration be verified/updated after a template has been imported and additional
configuration be supplemented using Section 5.4 in these Application Notes as a reference.

The SIP Line Template created from the configuration as documented in these Application Notes
is as follows:

<?xml version="1.0" encoding="utf-8"7?>

<Template xmlns="urn:SIPTrunk-schema">
<TemplateType>SIPTrunk</TemplateType>
<Version>20130710</Version>
<SystemLocale>enu</SystemLocale>
<DescriptiveName>Voice Carrier</DescriptiveName>
<ITSPDomainName>avayatest.callingcloud.net</ITSPDomainName>
<SendCallerID>CallerIDDIV</SendCallerID>
<ReferSupport>true</ReferSupport>
<ReferSupportIncoming>2</ReferSupportIncoming>
<ReferSupportOutgoing>2</ReferSupportOutgoing>
<RegistrationRequired>false</RegistrationRequired>
<UseTelURI>false</UseTelURI>
<Check00S>true</Check00S>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<LineNamePriority>SystemDefault</LineNamePriority>
<UpdateSupport>UpdateNever</UpdateSupport>
<UserAgentServerHeader />
<CallerIDfromFromheader>false</CallerIDfromFromheader>
<PerformUserLevelPrivacy>false</PerformUserLevelPrivacy>
<ITSPProxy>192.168.243.180</ITSPProxy>
<LayerFourProtocol>SipUDP</LayerFourProtocol>
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />
<CompressionMode>AUTOSELECT</CompressionMode>
<UseAdvVoiceCodecPrefs>false</UseAdvVoiceCodecPrefs>
<CallInitiationTimeout>4</CallInitiationTimeout>
<DTMF Support>DTMF_SUPPORT_RFC2833</DTMF Support>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_G711</FaxTransportSupport>
<UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>
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<CodecLockdown>false</CodecLockdown>
<Rell00Supported>false</Rell00Supported>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>true</UseDefaultValues>
<ScanLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>

</Template>

To import the above template into a new installation:

1.

- E-E

IP Offices E Analogue Trunk -Line 1
‘5 BOOTP (4) Line Settings |4nalogue COptions
g% Cperator (3) |

=7 Atlankic CiE=
= Syste [ ew v ] H323 Line
‘+'_‘1| ™ — ]| Generate Analogue Trunk Template IP DECT Line
[ Cankr :
- Exten “f  Copy Settings From Template SIP Line
[l i . SIP DECT Line
= : ser (o c. Chrl+
H ﬁ HunbG( = Mew SIP Trunk From Template
-9 Short § 521 Copy ChelC

@ Servic 1
E-o RS (]
o e Incom] % Delete Ctrl+Del

EB) wanPq o validate

a#s Direct

£ Time: A
® @ Firewd Mew From Template (Binary)
e T
e[l TP Route (4 ] Line Appearance ID o1

B Arconnk Code 00

On the PC where IP Office Manager was installed, copy and paste the above template
into a text document named US_VoiceCarrier_SIPTrunk.xml. Move the .xml file to
the IP Office Manager template directory (C:\Program Files\Avaya\IP
Office\Manager\Templates). It may be necessary to create this directory.

Import the template into an IP Office installation by creating a new SIP Line as shown in
the screenshot below. In the Navigation Pane on the left, right-click on Line then
navigate to New - New SIP Trunk From Template:

3. Verify that United States is automatically populated for Country and VoiceCarrier is
automatically populated for Service Provider in the resulting Template Type Selection
screen as shown below. Click Create new SIP Trunk to finish the importing process.
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™ Template Type Selection

Locale
Country | nited States W |
Service Provider "-.-"n:ui-::EI:Zarrier v| [ ] Display &1
Create new SIP Trunk ] ’ Catizel ]
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